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 Basic Editing  2  

KEY TERMS
•  Clipboard 

•  copy 

•  cut 

•  document properties 

•  Go To 

•  gridlines 

•  multi-selection 

•  Navigation Pane 

•  Object Zoom 

•  paste 

•  Read Mode 

•  replace 

•  rulers 

•  scroll bars 

•  scroll box 

•  scroll buttons 

•  thumbnails 

•  wildcard 

 LESSON SKILL MATRIX 

Skill Exam Objective Objective Number

Changing and Organizing Document Views Change document views.
Customize the Ribbon.
Demonstrate how to use Zoom.
Split the window.

1.4.1
1.4.4
1.4.2
1.4.5

Navigating and Searching through a Document Search for text within document.
Find and replace text.
Demonstrate how to use
Find and Replace to format text. 
Demonstrate how to use Go To.

1.2.1
2.1.2
2.2.2

1.2.4

Selecting, Replacing, and Deleting Text 

Cutting, Copying, and Pasting Text Copy and paste text. 2.1.3

Removing Blank Paragraphs Remove blank paragraphs. 2.1.5

Changing Information in the Properties Add values to document properties. 1.4.6
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  S tar Bright Satellite Radio is the nation’s leading satellite radio company. 

The company sells its subscription service to automobile owners, home 

listeners, and people on the go with portable satellite radios. The pub-

lic relations department is responsible for promoting a favorable image 

of Star Bright Satellite Radio to the media, potential customers, and cur-

rent customers. Microsoft Word 2013 is the perfect tool for viewing and 

searching through the department’s many documents. In this lesson, you 

learn to navigate and view a document in Word. 

 SOFTWARE ORIENTATION 

 The View Tab 

 Word offers several different ways to view a document, locate text or objects quickly, and 
manipulate windows. After opening a document, you can access related commands on the 
View tab, shown in Figure 2-1. Use this fi gure as a reference throughout this lesson as well as 
the rest of the book. 

Minimize button Restore button

Close button

Ribbon Display OptionsMacros groupWindow groupZoom groupShow groupViews group

Figure 2-1 
 View tab 

 Word provides options to change a document’s onscreen appearance by viewing the document 
in Read Mode, Print Layout, Web Layout, Outline, and Draft view. Adding horizontal and, 
vertical rulers, or gridlines; increasing or decreasing the view of the document; arranging the 
document windows; viewing the document side by side; or splitting the document can also 
change the view on the screen. In addition, the Navigation Pane provides options for browsing 
and conducting a search in a document. 

 CHANGING AND ORGANIZING DOCUMENT VIEWS  

You can enable features to show gridlines, thumbnails, and rulers to help in navigating the docu-
ment, or you can zoom in or out. Word also allows you to open and arrange multiple document 
windows. You learn about all these features in this section. 

 Opening an Existing Document 

 Word can open fi les that have been saved in Word format or many other popular formats, such as 
.RTF, .TXT, or .PDF. You can edit the documents in Word and save the document in the original 
fi le format or another fi le format. The Open button in the Open dialog box contains a drop-down 
arrow that displays options for opening a document in a different manner. See Table 2-1 for a 
listing of options. In this exercise, you learn to open a document using the Open dialog box. 

The Bottom Line
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Figure 2-2

The new Open screen

Return to Document

Backstage
Commands

Table 2-1

Options for displaying 
the Clipboard

List Description

Open Read-Only Opens the document as a read-only fi le—no changes can be made to 
the document.

Open as Copy Opens a copy of the original document.

Open in Browser Opens the document that was saved as a web page in a web browser.

Open with Transform Opens documents that were saved with an XML fi le type.

Open in Protected View Opens documents in protected view—to edit, click Enable Editing.

Open and Repair Opens and repairs corruption to the document.

 Clicking the Open command in the File tab produces the new Open screen. You can locate a fi le 
quickly in the Recent Documents where it displays the last 25 documents you accessed. From any 
computer, you can open documents that were saved to the Cloud using SkyDrive. Or, you can 
open documents that were saved to your local Computer. The Open dialog box opens when you 
click  Computer , and then click  Browse . You can open existing documents from locations such as 
a fl ash drive, hard drive, network location, desktop, or portable device. For the purpose of these 
exercises, the instructions assume that all data fi les are stored on your fl ash drive. 

 Saving documents in Compatibility Mode is covered in Lesson 1. 

 STEP BY STEP Open an Existing Document 

  GET READY.  Before you begin these steps, be sure to turn on and/or log on to your 
computer and start Word 2013. 

1.  Connect your fl ash drive to one of the USB ports on your computer. 

2.  Click the  File  tab to open Backstage. 

3.  Click  Open . The new Open screen is shown on the left side whereas the right side 
displays the recently opened documents. 

4.  Click  Computer ; notice the right side of the screen displays the current recent folders. 
(See Figure 2-2, but note that your screen will not be identical to the fi gure.) 

Cross 
Ref
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5.  Click the  Browse  button. The  Open  dialog box appears. 

6.  Use the scroll bar and scroll down and locate the data fi les for this lesson on your fl ash 
drive. Double-click the  Lesson02  folder to open it. 

7.  Locate and click  Star Bright Satellite Proposal  once, as shown in Figure 2-3. 

8.  Click the  Open  button. The document appears. 

Another Way
To open a docu-

ment quickly, double-click the 
fi lename.

Figure 2-3

Open dialog box with
subfolder

File path 
location on
flash drive

  PAUSE. LEAVE  the document open to use in the next exercise. 

 Changing Document Views 

 The View tab on the Ribbon has groups of commands for Views, Show, Zoom, Window, and 
Macros. In this section, you learn to use the Document Views command group to change the way 
Word displays your document. 

 Word has fi ve Document View options: 

•   Read Mode  changes the page layout of the document with a larger font for easier reading. Some 
tools are available for editing and navigating through the document. To advance to the next 
page, click the arrow key on the right of the screen or tap if you are using a touch screen. 

•   Print Layout  is the default view. It displays the document as it will look when printed and en-
ables you to use the Ribbon to create and edit your document. 

•   Web Layout  view shows how the document would look as a web page. 

•   Outline  view displays the document as an outline and offers an Outlining tab with commands 
for creating and editing outlines. 

•   Draft  view is strictly for editing text. Advanced elements such as charts, graphs, pictures, and 
other objects are hidden in this view. 
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STEP BY STEP Change Document Views 

USE  the document that is open from the previous exercise. 

1.  Click the  View  tab to see the command groups that are available. 

2.  In the Views group, click the  Read Mode  button to change the view of the document as 
shown in Figure 2-4. The document page layout changes with an increased font size for 
easier reading. 

How would you change the 
document views?

1.4.1

Figure 2-4

Read Mode view

Menu bar

Previous button Next button

3.  Click  Tools  on the menu in the upper-left corner of the screen to produce the Tools 
options menu, as shown in Figure 2-5. Four additional commands appear. Note that 
the fi rst two options are active whereas Can’t Undo and Can’t Redo are inactive. The 
inactive commands change to active after an action has been performed. 

Figure 2-5

Tools options menu

4.  Click  View  on the menu to produce additional commands, such as Edit Document, 
Navigation Pane, Show Comments, Column Width, Page Color, and Layout. 

5.  Hover the mouse over each command to view a ScreenTip, and then click  Edit 

Document . The screen changes to the Print Layout view for editing. 

6.  Click the  Read Mode  button again. 

7.  Click  View  on the menu, and then click  Navigation Pane . The pane opens on the left 
side of the screen. This allows you to navigate your document quickly by selecting 
headings and pages, or by searching for text.  

8.  In the Navigation Pane, click  Option 3  and notice that your document jumps to that 
location. Option 3 is formatted with a heading style.  
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 You learn more about styles in Lesson 3. 

9.    Click the  Pages  tab, and then click the fi rst page. Page images are called  thumbnails . 

10.  Click  Close   (X)  on the Navigation Pane to close. 

11.  Press  Esc  to turn off Read Mode view and return to the Print Layout view. 

12.  Click the  Web   Layout  button in the View tab. This view allows you to see the document 
as a web page. 

13.  Click the  Outline  button, and notice the Outlining tab and the groups of commands that 
appear for editing outlines. 

14.  Click the  Close   Outline   View  button. 

15.  Click the  View  tab, and then click the  Draft  view button. This view is typically used for 
editing text. 

16.  Click the  Print   Layout  view button to return the view of the document back to its default 
setting. 

17.  Note that some of the View options buttons are also available on the status bar at the 
bottom right of your screen . Click each button and compare the resulting 
views with the views you accessed from the View tab. 

18.  You can also adjust your screen to change the way the Ribbon displays. In the upper-
right corner, click the  Ribbon Display Options   button. 

19.  Select  Auto-hide Ribbon . The Ribbon is hidden to provide more document workspace. 

20.  Click the  Ribbon Display Options   button, and   then select  Show Tabs —only the tabs 
are shown. 

21.  To return the screen to its original settings, click the  Ribbon Display Options   button 
and select  Show Tabs and Commands  (see Figure 2-6). 

Cross 
Ref

How would you customize 
the Ribbon? 

1.4.4

Figure 2-6

Ribbon Display Options menu

  PAUSE. LEAVE  the document open to use in the next exercise. 

 Lesson 12 covers using Outline view in master documents. 

 Using Show Commands 

 The Show command group offers options for displaying various onscreen features that can help 
you create, edit, and navigate your document. In this exercise, you display the ruler and gridlines. 
You also use the Navigation Pane to browse by headings and by page and to search for text. 

  Rulers    are measuring tools to align text, graphics, and other elements within a document. The 
horizontal ruler can be used to change a document’s fi rst-line indent, hanging indent, and left and 
right indents. The markers display on the ruler as fi rst-line indent , hanging indent , left 
indent , and   right indent . Manual tab settings can be set on the horizontal ruler without 
launching the Tabs dialog box. 

  Gridlines  provide a grid of vertical and horizontal lines that help you align graphics and other objects 
in your documents. Gridlines are displayed only in Print Layout view and are non-printable objects. 
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 Tabs are discussed in greater detail in Lesson 4. 

 The  Navigation Pane  appears in the left side of the window when you select its check box in the 
Show group. The Navigation Pane has three tabs. The fi rst tab, Headings, displays the structure 
of your document by levels based on the document’s headings styles. The second tab, Pages, dis-
plays  thumbnails —tiny images of your document pages. The third tab, Results, displays a list of 
search results when you have used the Navigation Pane’s search tool (marked by a search box and 
magnifying glass icon) to look for particular text or objects in your document. 

 On the Results tab, the user can type text in the Search text box, and Word searches the docu-
ment for every incident where the text occurs. Under the Results tab, a list appears with text or 
objects found in the document in the order those elements appear in the document. For example, 
the search results might indicate that the fi rst instance of a word appears on page fi ve, the next 
instance appears on page eight, and so on. The text in the document appears highlighted in a light 
yellow and the text is bolded in the Results tab. 

 You can also see the results of the search in other tabs. In the fi rst tab, Headings, the section that 
has the found instance appears highlighted in yellow. In the Pages   tab ,  the thumbnail instances 
found appear highlighted in a light yellow. To clear the search box, click the  X  in that box.  

 In this exercise, you learn to use Show commands. The Navigation Pane is discussed later in this lesson. 

 STEP BY STEP Use Show Commands 

  USE  the document that is open from the previous exercise. 

1.  In the Show command group, click the  Ruler  check box to insert a check mark and 
activate the command. The horizontal and vertical rulers appear. 

2.  Click the  Gridlines  check box. A grid appears behind text on the page, as shown in 
Figure 2-7. 

Cross 
Ref

Figure 2-7

Gridlines and rulers

Ruler and Gridlines
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3.  Click the  Gridlines  check box to remove the check mark. 

  PAUSE. LEAVE  the document open to use in the next exercise. 

 Using Zoom 

 The Zoom group of commands lets you zoom in to get a closer view of a page or zoom out to see 
more of the document at a smaller size. These commands also enable you to determine how many 
document pages Word displays within a single screen.  Object Zoom  is new in Read Mode and 
allows you to zoom in on objects such as tables, charts, or images while in Read Mode. In Lesson 
6, you practice using the Object Zoom. In this exercise, you use the Zoom commands to view one 
or two pages; you also use the Zoom slider in the status bar to increase or decrease the size of the 
displayed image.  

 Within the Zoom group, the Page Width button expands your document to fi t the width of the 
window. The Zoom button launches the Zoom dialog box, where you have more options for 
zooming in and out. For instance, you can enter a specifi c number in the Percent box to modify 
the view or view multiple pages. Similarly, in the Zoom to section, you can expand the document 
by clicking a specifi c zoom amount up to 200%. The preview area shows how the document will 
appear on screen. The Zoom slider can also be used to zoom in and out; this slider is located in the 
bottom right of your screen on the status bar. The Zoom slider is also located in the Print screen 
of Backstage. 

 STEP BY STEP Use Zoom 

  USE  the document that is open from the previous exercise. 

1.  Click the  One   Page  button in the Zoom command group to display one entire page on 
the screen. 

2.  Click the  Multiple Pages  button to switch to a display of multiple pages. 

3.  Click the  Zoom   button. The Zoom dialog box appears, as shown in Figure 2-8. 

Figure 2-8

Zoom dialog box

View multiple
pages icon

Zoom options

Preview area

4.  Click the option button beside 200% in the Zoom to area of the dialog box, and then 
click  OK . The document image enlarges to twice its full size. 

 To use the Many Pages option in the Zoom dialog box, hover over the thumbnails and click the 
number of pages to display on the screen. 

Take Note
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5.  Click the  Zoom   Out   button on the Zoom slider, which is located at the right end 
of the status bar (see Figure 2-9). Each time you click the Zoom Out button, Word 
decreases the size of the displayed portion of your document by 10%. Click until the 
Zoom Out indicator displays  60% . 

6.  Click the Zoom In  button on the Zoom Slider, as shown in Figure 2-9. Zoom to  80% . 

Figure 2-9

The Zoom In and Zoom Out 
buttons on the Zoom slider

Zoom out Zoom inZoom Slider
Clicking the percentage
will open the Zoom 
dialog box

7.  Drag the Zoom slider all the way to the left; Word reduces the document to thumbnail 
size. 

8.  Now, in the Zoom command group on the View tab, click the  Page   Width  button. The 
document display expands to the width of the window. 

9.  Click the  100%  button to return document to its normal size. 

  PAUSE. LEAVE  the document open to use in the next exercise. 

 Changing Window Views 

 The commands in the Window command group enable you to open and arrange multiple doc-
ument windows. In this exercise, you learn to manipulate your screen by creating a second doc-
ument in a new window, arranging multiple open documents on one screen, splitting a single 
document to view different parts, viewing multiple documents side by side, resetting window 
positioning to divide the screen equally, and switching between windows. 

 The commands in the Window command group are as follows: 

•  The  New Window  button opens a new window displaying the current document; this window 
shows the document name in the title bar followed by the number 2. Each new window you 
open in the same document receives a chronologically numbered name. This feature allows you 
to work in different places in your document. 

•  The  Arrange All  button displays two or more windows on the screen at the same time. This is 
useful when comparing documents or when using information from multiple documents. 

•  The  Split  command divides one document window into two windows that scroll independently. 
This enables you to view two parts of a single document at the same time. 

•  The  View Side by Side  button allows you to view two documents next to each other. When you 
are viewing documents side by side, you can use the  Synchronous Scrolling  command to link 
the scrolling of the two documents so that you move through both at the same time. 

• The   Reset Window Position  button is used with the View Side by Side button, and when 
viewing two documents side by side, the Reset Window Position button will position both doc-
uments equally on the screen. 

•  The  Switch Windows  button allows you to select which document will be the active docu-
ment (the document that is ready for editing). The name of the active document appears on 
the title bar. 

 On occasion, you might need to move a window out of the way without exiting the associated appli-
cation. This is where the three buttons in the upper-right corner of the Word screen come in handy. 
The Minimize button  minimizes the window display—in other words, the window disappears 
and is replaced with an icon on the Status task bar Restore button  returns a document to its pre-
vious size by minimizing or maximizing its display. Finally, the Close button  closes the window. 
If you have only one Word document open, the close button will also close Word. 

Another Way
You can also click 

the percentage displayed to 
the right of the Zoom slider to 
open the Zoom dialog box.

How would you use the 
Zoom command?
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STEP BY STEP Change Window Views 

USE  the document that is open from the previous exercise. 

1.  In the Window command group, click the  New   Window  button. A new window with 
 Star Bright Satellite Proposal:2    in the document title bar appears and becomes the 
active document. 

2.  In the Window command group, click the  Switch Windows  button. A menu of open 
windows appears, as shown in Figure 2-10. 

Figure 2-10

Switch Windows button 
and menu

3.  In the Switch Windows drop-down menu, click  Star Bright Satellite Proposal:1 . The 
original document becomes the active document. 

4.  Click the  Arrange All  button. Word displays the two windows, one above the other, on 
your screen, as shown in Figure 2-11. Figure 2-11

Two windows displayed using 
the Arrange All command

Star Bright Satellite Proposal:1

Star Bright Satellite Proposal:2

5.  Click the  View   Side by Side  button to arrange the windows beside each other on the screen. 

6.  Note that  Synchronous Scrolling  is on by default. Place your insertion point on the 
slider in the vertical scroll bar and press the left mouse button as you move the slider 
up and down to scroll through the documents; notice that both scroll simultaneously. 

7.  Click anywhere in the  Star Bright Satellite Proposal:2  document; this now becomes the 
active document. 

8.  Click the  Synchronous Scrolling  button to turn off that feature. Place your insertion 
point on the vertical scroll bar and scroll down; notice that the  Star Bright Satellite 

Proposal:2  document is now scrolling independently. 

ddoccoccumennnt becoooommem s the active document. 
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9.  Click the  Close   button to close the  Star Bright Satellite Proposal:2  document. 

10.  Click the  Maximize  button on the  Star Bright Satellite Proposal  document to fi ll the 
screen. 

11.  Click the  Split  button. Notice you now have a horizontal split bar. Drag the split bar 
below the text Relocation Proposal and release the mouse button. Splitting your 
document makes it easy to edit two different sections. The document window splits in 
two and the  Split  button changes to a  Remove Split  button (see Figure 2-12).  

How would you split the 
window?

1.4.5

Figure 2-12

Split window and Remove 
Split button

Split bar

12.  Click  Remove Split . 

13.  Click the  Minimize   button. The document minimizes to become an icon in the 
Windows task bar at the bottom of the screen, and the desktop appears. 

14.  Hover your mouse over the Word icon in the task bar (as shown in Figure 2-13), and then 
click the  Star Bright Satellite Proposal  document’s icon in the task bar to maximize the 
document on the screen. 

Figure 2-13

Document minimized 
to task bar

  PAUSE. LEAVE  the document open to use in the next exercise. 



Lesson 248

 NAVIGATING AND SEARCHING THROUGH A DOCUMENT 

 As you already learned, the Navigation Pane contains commands for moving and searching 
through a document. You also can use Find command options, the mouse, scroll bars, and various 
keystroke and keyboard shortcut commands to navigate through Word documents. In this sec-
tion, you practice using the mouse and scroll bar, keystroke commands, the Navigation Pane, and 
a number of command group commands to move quickly through a document; search for specifi c 
text, graphics, or other document elements; and remove or replace those elements. 

  Scroll bars  allow a user to move up or down or side to side within a document. In Word, a ver-
tical scroll bar   appears on the right side of the document window, as shown in Figure 2-14; if the 
document view is larger than the viewing area, a horizontal scroll bar also appears at the bottom 
of the window to allow you to scroll left and right across the width of the document. You can click 
the  scroll     buttons  to move up or down one line at a time, or you can click and hold a scroll button 
to scroll more quickly. You can also click and drag the  scroll box  to move through a document 
even faster or just click the scroll box to see a ScreenTip displaying your position in the document. 

The Bottom Line

Scroll button

Scroll box

Scroll bar

Scroll button

Figure 2-14

Scroll bar, scroll box, and 
scroll buttons

rrrollolloo bbob x
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 Using the Mouse and Scroll Bar to Navigate 

 Using the mouse in combination with the scroll bar is a simple way to scroll through a document. 

 STEP BY STEP Use the Mouse and Scroll Bar to Navigate 

  USE  the document that is open from the previous exercise. 

1.  Click the  scroll down  button to scroll down one line at a time. 

2.  Click and hold the  scroll down  button until you scroll all the way to the end of the document. 

3.  Drag the  scroll box  all the way to the top of the scroll bar; the view quickly scrolls to the 
beginning of the document. 

4.  Position the mouse pointer on the  scroll box . Click and hold to see a ScreenTip 
identifying your current location in the document (see Figure 2-15). 

Figure 2-15

Scroll box ScreenTip
Position mouse
pointer on scroll
box; click and 
hold to see
Screen Tip

  PAUSE. LEAVE  the document open to use in the next exercise. 

hooold dd to see
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 Using Keystrokes to Navigate 

 The arrow keys and other keyboard commands can also help you move through a document.  

 STEP BY STEP Use Keystrokes to Navigate 

  USE  the document that is open from the previous exercise. 

1.  In the fi rst line of the body of the document, position the insertion point before the  S  
in  Star . 

2.  On the keyboard, press the    Right arrow    key to move the insertion point one character 
to the right. 

3.  Press the    Left arrow    key to move one character to the left. 

4.  Press the    Down arrow    key to move down one line. 

5.  Press the  End    key to move to the end of the line. 

6.  Press the    Page Down    key to move down one screen. 

7.  Press the  Ctrl 1 Home  keys to move to the beginning of the document. 

  PAUSE. LEAVE  the document open to use in the next exercise. 

 Table 2-2 lists these and other shortcut keys and keystroke commands you can use to navigate 
through a document. Use Help to search for additional shortcuts. 

Table 2-2

Keyboard shortcuts for 
navigating a document

Shortcut Key Related Move

Left arrow One character to the left

Right arrow One character to the right

Up arrow Up one line

Down arrow Down one line

End To the end of the line

Home To the beginning of the line

Page up Up one screen

Page down Down one screen

Ctrl1Page down Down one page

Ctrl1Page up Up one page

Ctrl1Home To beginning of the document 

Ctrl1End To end of the document

 Searching within a Document 

 Word’s Find command is now located in the Results tab on the Navigation Pane. You can open the 
Navigation Pane in the Show group on the View tab, as well as by clicking the Find button on the 
Home tab in the Editing group. By using the Navigation Pane, you can easily locate specifi c text, 
graphics, objects, and equations within a document. The document contains highlighted text, and 
the Results tab displays the results in bold. Word places the results in the order they appear in the 
document. In this exercise, you learn to use the Navigation Pane to search for every occurrence of 
a specifi c word within a document.  

 In the Home tab on the Editing group, the drop-down arrow by the Find button displays a menu 
that contains the Find, Advanced Find, and Go To commands. The Find command opens the 

stsss tthehh se aaandndnd othhheere ssshohohortrr cut t tt kekekeys and kkkeyyystststrororokekeke cccomomommmandndnds s s 
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Navigation Pane with the Results tab active; the Advanced Find command opens the Find and 
Replace dialog box with Find as the active tab; and the Go To command opens the same dialog 
box with Go To as the active tab. In the Editing group, the Replace command opens the Find 
and Replace dialog box with Replace as the active tab. The Select command provides options in 
selecting text or objects. 

 To highlight every occurrence of a particular word or phrase in your document, you must 
activate Advanced Find. To do so, click the drop-down arrow by the Search text box, as shown 
in Figure 2-16, and then click  Advanced Find . The Find and Replace dialog box opens. Within 
the Find what box, type your desired word or phrase, and then click the drop-down arrow on the 
Reading Highlight button and select  Highlight All . When you close the Find and Replace dialog 
box, each instance of your desired word or phrase is highlighted in the document. To clear all 
occurrences of highlighted text, return to the Advanced Find options, click the  Reading Highlight  
button, and then select  Clear Highlighting . 

The magnifier and drop-down 
arrow displays additional 
commands

Advanced Find opens the Find and 
Replace dialog box with Find as 
the active tab

Replace opens the Find and Replace 
dialog box with Replace as the active 
tab

Go To opens the Find and Replace 
dialog box with Go To as the active 
tab

Figure 2-16

Navigation Pane displaying 
additional options

 STEP BY STEP Use the Navigation Pane to Search for Text in a Document 

  USE  the document that is open from the previous exercise. 

1.  Click the  View  tab, and then in the Show command group, click the  Navigation Pane 

 check box. The Navigation Pane opens. 

2.  Type  relocation  in the Search text box; the text is highlighted in the document and 
results are shown in the Headings, Pages, and Results tabs of the Navigation Pane. 

Th
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3.  Click the third tab,  Results . Note that the found text is bolded, and it appears in the 
order of its occurrence in the document. 

4.  Click the fi rst tab,  Headings , and note the headings of sections that contain the found 
text are highlighted.  

5.  Click the second tab,  Pages , and note the highlighted found text in the thumbnails. 

6.  Click each  thumbnail  until you get to page 4. 

7.  Click the  X  in the Search text box to end your search. Word automatically returns to 
page one. 

8.  Click the  magnifying glass  icon on the right side of the Navigation Pane box to open a 
list of available Options. 

9.  From the Options list opened, click the  Advanced Find  command. The  Find and Replace  
dialog box opens. 

10.  The word “relocation” should be in the Find what text box; click the  Find Next  button. 
Click  Yes  to return to the top of the document, if prompted. 

11.  Click the  Reading Highlight  button and select  Highlight All  to highlight all instances of 
this word. Review each page. 

12.  Before closing the Find and Replace dialog box, remove the highlight from the text by 
clicking the  Reading Highlight  button; and then  Clear   Highlighting  (see Figure 2-17). 

13.  Click  Close . 

Another Way
To open the 

Navigation Pane using the 
keyboard, press Ctrl1F, or you 
can click the Find drop-down 
arrow in the Editing group on 
the Home tab.

Figure 2-17

Reading Highlight

14.  In the Show command group, click the  Navigation Pane  check box to turn off this pane. 

 To end your search, click the  X  in the text box. 

15.   SAVE  the document as  Star Bright Satellite Proposal   1  in the lesson folder of your fl ash 
drive. 

  PAUSE.   LEAVE  the document open to use in the next exercise. 

 For more search options, click the  More .  .   button in the Find and Replace dialog box. In 
the Search Options area that appears, you can choose additional criteria to refi ne the search 
process—for example, you can choose to match case or whole words only. You can also use 
 wildcard  characters to fi nd words or phrases that contain specifi c letters or combinations of 
letters. Simply type a question mark (?) to represent a single character—for example, typing  b?t  
fi nds  bat ,  bet ,  bit , and  but . Similarly, type an asterisk (*) to represent a string of characters—for 
example,  m*t  fi nds  mat ,  moment , or even  medium format . 

 Within the Find and Replace dialog box, you can click the Format button to fi nd text with specifi c 
formatting, such as a particular font, paragraph setting, or style. You can also click the  Special  
button to fi nd special elements in a document, such as fi elds, footnote marks, or section breaks. 

Take Note

How would you search 
for text? 

1.2.1
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 Finding and Replacing Text in a Document 

 Located on the Home tab in the Editing group, the Replace command opens the Find and Re-
place dialog box. You can use the Replace command to replace one word or phrase with another. 
You can also use the Find and Replace command to search for and  replace  formatting—such as a 
specifi c font color, bolding, or italics. It is also possible to search for and replace special characters 
and document elements such as page breaks and tabs. In this exercise, you learn to search for and 
replace a word with a particular type of formatting. 

 STEP BY STEP Replace Text in a Document 

  USE  the document that is open from the previous exercise. 

1.  Place the insertion point at the beginning of the document by pressing  Ctrl  1Home . 

2.  Click the  Home  tab to make it active. In the Editing group, click the  Replace  button; the 
 Find and Replace  dialog box opens. 

3.  Click the  More >  >   button to review the options, and then click the   <  < Less  button to hide 
them. 

4.  In the Find what box, type  Montgomery, Slade, and Parker . (If “relocation” appears in 
the Find what box, select it and press  Delete , and then type in the new search string.) 

5.  In the Replace with box, type  Becker, Steele, and Castillo . 

6.  Click  Find Next . Word searches for the fi rst occurrence of the phrase  Montgomery, 

Slade, and Parker  and highlights it. Note: If Word does not fi nd any matches, check the 
spelling in the Find what text box. 

7.    Click  Replace All . Word searches for all occurrences of the phrase  Montgomery ,  Slade , 
and  Parker  and replaces them with  Becker ,  Steele , and  Castillo . Word then displays a 
message revealing how many replacements were made, as shown in Figure 2-18. 

Another Way
To open the 

Replace tab in the Find and 
Replace dialog box using the 
keyboard, press Ctrl1H.

Figure 2-18

Find and Replace message

8.    Click  OK , and then click  Close . 

9.  Position the insertion point at the beginning of the document. 

10.  Click the  View  tab; then, in the Show command group, click the  Navigation   Pane  
check box. 

11.  In the Navigation Pane, click the drop-down arrow or magnifi er so that the ScreenTip 
displays Search for more things; then, click  Replace  to open the  Find and Replace  
dialog box. 

12.  In this next step, you reverse the search order. In the Find what text box, type  Becker, 

Steele, and Castillo ; then, in the Replace with text box, type  Montgomery, Slade, and 

Parker . Keep your insertion point in the Replace with text box.  

13.  Click the  More >>     button to expand the dialog box to include additional search and 
replace options (see Figure 2-19). 

14.  Click the  Format  button and select  Font  from the drop-down list; the Replace Font 
dialog box appears. 

15.  In the Font area, use the scroll bar to scroll to  Garamond , and then click to select it.  

16.    In the Font Style area, select  Bold Italic . 

17.  Select size  14 . 

18.    Click the  Font Color  drop-down arrow, and then select  Dark Red  in the Standard Colors 
and preview the results. 

, p , yp

e ReReReplaceee wwiw th bbbooxo , tytytypepp  BeBeBeckckcker, Steeeeeelelele,,, ananand d d Caaastststilii lo.
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19.  Click  OK . Below the Replace with text box, you see the format selections—refer to 
Figure 2-19. 

20.  Click  Replace All ; two replacements will be completed. 

21.  Click  OK , and then click  Close . Inspect your document and notice that the replacements 
have been made with formatting changes. 

Replace formatting

The Special command allows you to find/replace 
one element with another

Removes formatting in the Find 
what and Replace with text boxes

Format button with
options to select

<<Less button will
display less options

Options to control how
search will be conducted

Figure 2-19

Find and Replace dialog box 
with Search Options

22.  On the Navigation Pane, click the  X , or on the Show command group, click the check 
box for Navigation Pane to close. 

23.  Click the Show/Hide button to display the nonprinting characters. 

24.  To use the Advanced Search feature, click the  Home  tab, and in the Editing group, click 
 Replace . 

25.  Place the insertion point in the Find what text box, and select and delete any text in the 
box by pressing  Backspace  or  Delete . 

26.  Place your insertion point in the Replace with text box, select and delete any text in that 
box by pressing  Backspace  or  Delete  and click the  No Formatting  button at the bottom 
of the screen—this removes all formatting in the Replace with text box. 

27.  Place your insertion point in the Find what text box, and then click the  Special  button. 
In the list of searchable elements that appears, click  Section Break ; Word places the 
characters  (^b)  in the text box. 

28.  Place your insertion point in the Replace with text box. Click the  Special  button. 

29.  Click  Manual Page Break ;  (^m)  appears in the text box. 

30.  Click  Find Next , and notice that Word highlights the fi rst occurrence. Click  Replace All . 
Three replacements are made in the document and the document has Page Breaks 
instead of Section Breaks. 

31.  Click  OK , and then click  Close  to close the  Find and Replace  dialog box. 

32.  Review the page breaks in the document and leave the Show/Hide button on. 

33.   SAVE  the document on your fl ash drive as  Star Bright Satellite Proposal   Update . 

  PAUSE.   LEAVE  the document open to use in the next exercise. 

2.1.2

How would you locate text 
in a document?

How would you use Find and 
Replace to format text?

2.2.2
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 Section and manual breaks are covered in Lesson 5. 

 You can use the Find and Replace tool to replace specifi c punctuation within a document. For 
instance, say you pressed the spacebar twice at the end of each sentence and you would like to 
replace each set of two spaces with only one space. In the Find what text box, press the  Spacebar  
twice; then in the Replace with text box, press the  Spacebar  once and click the Replace All button. 
Upon doing this, Word replaces all instances of double spacing with single spaces.

When replacing text, you can confi rm each replacement to make sure it is correct by clicking 
 Replace  instead of Replace All. Using the Find and Replace command assists you in fi nding text 
and avoiding mistakes. 

 If you experience problems when using the Replace command to replace formatting or one 
of the special elements, display the Find and Replace dialog box again. Review the Find what 
text box for correct spelling or correct element. Below the Replace with text box is the For-
matting to replace text. For instance, if you are replacing search text with a red color and 
bold as the style, below the Replace with text box, you see  Font: Bold, Font color: Red  (refer 
to Figure 2-19). 

 Using the Go To Command to Navigate a Long Document 

 In a longer document, you might want to move through the document more quickly than is possi ble 
by scrolling. The  Go To  command provides a way to navigate through longer documents quickly. 
In this exercise, you learn to use the Go To command to move through a lengthy document. 

 Using the Go To command jumps to a specifi c page, table, graphic, equation, or other item in your 
document. To go to the next or previous item of the same type, leave the Enter box empty, and 
then click  Previous  or  Next . The Go To command is located in the Find and Replace dialog box. 

 STEP BY STEP Use the Go To Command 

  USE  the document that is open from the previous exercise. 

1.  On the  Home  tab, in the Editing group, click the drop-down arrow next to the Find 
button, and then click  Go To . The Go To tab of the Find and Replace dialog box is 
displayed, as shown in Figure 2-20. 

Cross 
Ref

Take Note

Troubleshooting

Use scroll bar or 
arrow to view 
options

Enter value in the box

Additional 
options to 
select

Figure 2-20

Go To tab
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2.  In the Go to what box, Page is selected by default. In the Enter page number box, type  4 , 
and then click    Go To . The insertion point moves to page 4 of the document. 

3.  In the Go to what box, select  Line . In the Enter line number   box, type  10 , and then click  
  Go To . The insertion point moves to line 10 in the document. 

4.  In the Go to what box, select  Bookmark . In the Enter bookmark name box, Option_1 
displays. Click  Go To . The insertion point moves to the bookmark. 

5.  Click the drop-down arrow in the Enter bookmark name box and select  Top , and then 
click  Go To . The insertion point is placed at the beginning of the document. 

6.  Click  Close . 

  PAUSE.   LEAVE  the document open to use in the next exercise. 

 Bookmarks and hyperlinks are described in Lesson 12. This is another way to navigate through a 
document quickly. 

 Word keeps track of where you typed or edited text. To go to a previous editing location in your 
document, press  Shift 1 F5 . After saving your document in your computer, fl ash drive, or SkyDrive, 
Word 2013 will remember where you left off in your document. 

 SELECTING, REPLACING, AND DELETING TEXT 

 Word offers a number of tools for selecting, deleting, and replacing text. You also can apply for-
matting to selected text. In this exercise, you use the mouse and keyboard to select text and delete 
it or replace it with new text. 

 Selecting, Replacing, and Deleting Text 

 You can delete text in Word documents by pressing the  Backspace  key to delete characters to the 
left of the insertion point, pressing the  Delete  key to delete characters to the right of the insertion 
point, or selecting text and pressing either the  Delete  key or  Backspace  key. In this exercise, you 
learn to select and delete text and to type in replacement text. You also practice using the Undo 
and Redo buttons in the Quick Access Toolbar.  

 The    multi-selection  feature of Word enables you to select multiple text items that are not contin-
uous. For example, to select every other line in a paragraph, select the fi rst line, and then press and 
hold the  Ctrl  key as you select the other lines by clicking the left mouse button. 

 To replace text in a Word document, simply select the text you want to replace, and then type new 
text. To cancel a selection, click in any blank area of the document screen. 

 STEP BY STEP Select, Replace, and Delete Text 

  USE  the document that is open from the previous exercise. 

1.  Position your insertion point a t the beginning of the fi rst body paragraph, under the 
Proposal Description heading. The insertion point is to the left of the   S   in   Star.   Click 
and drag across until   Star Bright Satellite Radio   is selected.  

2.   Type   SBSR  .   Star Bright Satellite Radio   is replaced with   SBSR  .  

3.   In the fi rst sentence of the fi rst paragraph, position the insertion point after the word 
  streamline  .  

4.   Press   Backspace   multiple times to delete the word   streamline  , and then     type   restructure  .  

5.   Position the insertion point in the fi rst paragraph.  Triple-click  the mouse to select the 
entire fi rst paragraph.  

Another Way
To open the Go To 

tab in the Find and Replace 
dialog box using the keyboard, 
press Ctrl1G or press F5.

Cross 
Ref

Take Note

The Bottom Line

How would you Go To specifi c 
places in a document?

1.2.4
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6.   Position the insertion point at the beginning of the fi rst paragraph under Proposal 
Description. To select multiple text, press and hold the   Ctrl   key and double-click every 
other word on the fi rst line beginning with   SBSR  . Every other word is now selected.  

7.   Click in a blank part of the page, such as the margin, to deselect the selected words.  

8.   Then place your insertion point at the beginning of the same paragraph, beginning 
with   SBSR is the nation’s leading. . .   and click. Move the I-Beam pointer to the end of 
the sentence (  restructure operations  ), press the   Ctrl   key, and click. The sentence is now 
selected.  

9.   Press   Backspace     or   Delete   to delete the sentence.  

10.   Click the   Undo    button in the Quick Access Toolbar to undo the action.  

11.     SAVE   the document as   Star Bright Satellite Proposal Second Update   in the lesson 
folder on your fl ash drive.  

  PAUSE. LEAVE  the document open to use in the next exercise. 

 When you position the mouse pointer to the left of the margin, it changes to a selection arrow that 
enables you to click to select the entire line to the right of the pointer. You then can drag down to 
continue selecting adjacent words, lines of text, or entire paragraphs. Table 2-3 lists this and other 
techniques for selecting text with the mouse.  

To Select Do This

Any amount of text Click and drag across the text

A word Double-click the word

A line Click in the left margin with the mouse pointer

Multiple lines Click and drag in the left margin

A sentence Hold Ctrl and click anywhere in the sentence

A paragraph Double-click in the left margin or triple-click in the paragraph

The entire document Triple-click in the left margin

Table 2-3

Selecting text with the mouse

To Select Key This

One character to the right Shift1Right Arrow

One character to the left Shift1Left Arrow

To the end of a word Ctrl1Shift1Right Arrow

To the beginning of a word Ctrl1Shift1Left Arrow

To the end of a line Shift1End

To the beginning of a line Shift1Home

To the end of a document Ctrl1Shift1End

To the beginning of a document Ctrl1Shift1Home

The entire document Ctrl1A

To the end of a paragraph Ctrl1Shift1Down Arrow

Table 2-4

Selecting text with 
the keyboard

 You also can use keyboard commands to select text. Table 2-4 shows various keyboard shortcuts 
you can press to select text. 

Another Way
The Select button 

in the Editing command group 
of the Home tab lets you select 
all text in a document, or select 
text with similar formatting.
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 CUTTING, COPYING, AND PASTING TEXT  

 It is often necessary to copy or remove text from one location in a document and place it in an-
other. When you use the copy or cut command, the  Clipboard  stores the items for you to paste 
in another location of the document or Offi ce fi le. When you  cut    text, Word removes it from the 
original location and places the deleted text in the Clipboard collection. When you  copy  text, 
Word places a duplicate copy in the Clipboard. The  Paste  command then pastes text from the 
Clipboard to a new location in either the original document or a new document. In this exercise, 
you learn two different ways to copy and move text—using the Clipboard and using the mouse. 

 Entries placed in the Clipboard can be placed anywhere in a document by positioning the in-
sertion point in the new location, and then selecting one of the three Paste options shown in 
Table 2-5 and Figure 2-21. 

The Bottom Line

Paste Option Description
Sample Item Placed 
on Clipboard

How Item Displays 
When Pasted

Keep source formatting Keeps the selected text with 
the original format, including 
hyperlinks.

WILEY.COM WILEY.COM

Merge formatting If the text contains fonts of 
different sizes and colors, the 
paste produces black text with 
Calibri (Body) 11-point format-
ting when in a new document 
screen. If pasting in the same 
document, the destination 
formatting is used.

Paste Paste

Keep text only Regardless of its font, size, and 
formatting, when pasted, the 
text appears in 11-point Calibri 
(Body).

College College

Table 2-5

Paste option descriptions

Keep Text Only

Merge Formatting

Keep Source 
Formatting

Figure 2-21

Paste options

 Copying and Moving Text with Clipboard Commands 

 The Clipboard enables you to cut or copy multiple items and paste them into any Offi ce document. In 
this exercise, you learn to use the Clipboard command group on the Home tab to copy and move text. 

 Collected items stay on the Clipboard until all Offi ce programs are closed or you click the Clear 
All button in the Clipboard task pane. The Clipboard holds up to 24 items and when another 
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item is added, the fi rst item is deleted from the Clipboard and the latest item is placed at the top 
of the list. Each entry in the Clipboard includes an icon representing the source Offi ce program 
and a portion of copied text or a thumbnail of a copied graphic. By default, when text is selected, 
a message appears on the status bar showing how many words are selected and the total number 
of words in the document.  

 STEP BY STEP Use the Clipboard to Copy and Move Text 

  USE  the document that is open from the previous exercise. 

1.  Triple-click to select the  second paragraph  of the document under the Proposal 
Description heading. 

2.  On the Home tab, in the Clipboard group, click the  Cut  button. When using the Cut or 
Copy command, the item is automatically placed in the Clipboard. 

3.  Click to place the insertion point in front of the fi rst character of the sentence that 
begins “ SBSR is the nation’s leading . . . ” 

4.  Click the  Clipboard  command group dialog box launcher to display the Clipboard task pane. 

5.  In the list of cut and copied items, move your mouse pointer to the text you cut in step 2, 
and click the drop-down arrow   to produce the menu shown in Figure 2-22. 

Another Way
To copy an item 

to the Clipboard using the 
keyboard, select the item, and 
then press Ctrl1C. To cut a se-
lected item using the keyboard, 
press Ctrl1X. To paste the 
item most recently collected on 
the Clipboard, click to locate 
the insertion point, and then 
press Ctrl1V on the keyboard. 
To produce a shortcut menu 
containing Cut, Copy, and Paste 
commands, right-click in the 
document.

Task Pane Options

24 items can be
placed on the

Clipboard

Options on how
to display the

Clipboard

Paste All button
pastes all items

from the
Clipboard to the

document

Clear All erases 
all items from the 
Clipboard

Close button

Figure 2-22

Clipboard task pane options
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6.    Click  Paste  to insert the text into the document in the new location. 

7.  Click the  Close  button on the Clipboard task pane. 

  PAUSE.   LEAVE  the document open to use in the next exercise. 

 Your Clipboard task pane might look different depending on how many items have been collected. 

 The Options drop-down arrow at the bottom of the Clipboard task pane offers multiple options 
for displaying the Clipboard. Table 2-6 describes these options. 

Take Note

Option Description

Show Offi ce Clipboard 
Automatically

Automatically displays the Clipboard when copying.

Show Offi ce Clipboard When 
Ctrl1C Pressed Twice

Automatically displays the Clipboard when you press Ctrl1C twice.

Collect Without Showing Offi ce 
Clipboard

The Clipboard is not displayed when copying or cutting text.

Show Offi ce Clipboard Icon on 
Taskbar

Displays the Clipboard icon in the status area of the system task bar 
when the Clipboard is active. Turned on by default.

Show Status Near Taskbar When 
Copying

Displays the “collected item” message when copying items to the 
Clipboard. Turned on by default.

Table 2-6

Options for displaying 
the Clipboard

 Using the Mouse to Copy or Move Text 

 To move a selection of text, use your mouse to drag and drop the selection in a new location. Hold 
the Ctrl key while you drag to copy the text. When you are moving text by dragging, the pointer 
shows a box, and when you are copying text by dragging, the pointer shows a box with a plus sign 
( 1 ). Text that you cut or copy using the mouse is not stored in the Clipboard collection. In this 
section, you learn to use the mouse to copy or move text. 

 STEP BY STEP Use the Mouse to Copy or Move Text 

  USE  the document that is open from the previous exercise. 

1.  Select the second paragraph on the fi rst page, beginning with “ SBSR is the nation's 
leading . . .”  

2.  Press the  Ctrl  key as you click, and then drag the selected paragraph and drop it above 
the fi rst paragraph on the fi rst page. The pointer shows a plus sign ( 1 ) as you drag, 
indicating that you are copying the selected text. The  “SBSR is the nations’ leading . . .”  
paragraph displays in the fi rst and third paragraph. 

3.  Select the third paragraph and press  Delete . 

4.   SAVE  the document as  Star Bright Satellite Proposal Final Update  in the lesson folder 
on your fl ash drive. 

  PAUSE.   LEAVE  the document open to use in the next exercise. 

 By default, drag-and-drop editing is turned on so that you can drag the pointer to move and 
copy text. This option can be turned on or off in Backstage view. To do so, click the  File  tab, 
and then click  Options . Click  Advanced  and, under Editing options, select or clear the  Allow 
Text to Be Dragged and Dropped  check box. (Advanced Word Options are covered in depth 
in Lesson 14.) 

Troubleshooting

How would you use the copy 
and paste commands?

2.1.3
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 Removing Blank Paragraphs 

 As you create a document or review an existing document, it is good practice to remove extra 
blank lines between paragraphs. In this section, you learn to remove blank paragraphs. 

 STEP BY STEP Remove Blank Paragraphs 

  USE  the document that is open from the previous exercise. 

1.  If necessary, enable the Show/Hide ( ¶ ). 

2.  In the fi rst page after the second paragraph, place the insertion point at the beginning 
of the paragraph mark and press  Delete . 

3.  On page two, remove the extra paragraph marks in the body text under the heading 
 Atlanta, GA  by pressing  Delete . Repeat these steps for page 3 to remove the extra 
paragraph marks under the heading  Dallas, TX  and on page 4 under the heading 
 Richmond, VA . 

4.   SAVE  the document with the same fi lename in the lesson folder on your fl ash drive. 

  PAUSE.   LEAVE  the document open to use in the next exercise. 

 CHANGING INFORMATION IN THE PROPERTIES 

 Backstage view enables you to access the properties to add information about the document, such 
as the author’s name, subject, company, and much more. In this exercise, you learn two different 
ways to add information to the properties. 

 Document properties identify the creator of the document, date the document was created, sub-
ject, category, and keywords that can be used to search for the document. 

 The Document Properties panel is displayed on the document screen, by accessing Info in the 
Backstage, and then selecting  Show Document Panel . The Show Document Panel displays the 
Document Properties below the Ribbon. You can access the Advanced Properties by clicking 
the drop-down arrow in the Document Properties, or you can open them through Backstage. 

 STEP BY STEP Change Information in the Properties 

  USE  the document that is open from the previous exercise. 

1.  Click  File  to open Backstage, and then click the drop-down arrow on the right-side of 
Properties to view the options as shown in Figure  2-23. 

The Bottom Line

Figure 2-23

Properties options

2.  Click  Show Document Panel . The Document Properties panel is displayed above the 
document. 

How would you remove 
blank paragraphs? 

2.1.5
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3.  Type the following information in the appropriate text box: 

 Author:  [Your Name]  

 Title:  Policies & Procedures  

 Subject:  Handbook  

4.  Click the drop-down arrow in the Document Properties located in the upper-left side of 
the panel as shown in Figure 2-24. 

Advanced Properties Location of file
Click to close 

Document Properties

Figure 2-24

Document Properties option to 
open Advanced Properties

5.  Click  Advanced Properties  to open the Properties dialog box, and then click the 
 Summary  tab to make it active. 

6.  Add the following information to the appropriate text box: 

 Manager:  Aggie Becker  

 Company:  Star Bright Satellite Radio  

 Keywords:  policies, procedures, benefi ts  (separate keywords with a comma) 

7.  Click  OK  to confi rm the update made to the properties, and then close the Document 
Panel by clicking the  X . 

8.   SAVE  the document in the lesson folder on your fl ash drive then  CLOSE  the document. 

  CLOSE  Word. 

How would you add 
information to the document 

properties?

1.4.6

SKILL SUMMARY
In This Lesson, You 
Learned to: Exam Objective Objective Number

Change and Organize Document 
Views 

Change document views.
Customize the Ribbon.
Demonstrate how to use Zoom.
Split the window.

1.4.1
1.4.4
1.4.2
1.4.5

Navigate and Search through a 
Document

Search for text within document.
Find and replace text.
Demonstrate how to use 

Find and Replace to format text. 
Demonstrate how to use Go To.

1.2.1
2.1.2
2.2.2

1.2.4

Select, Replace, and Delete Text 

Cut, Copy, and Paste Text Copy and paste text. 2.1.3

Remove Blank Paragraphs Remove blank paragraphs. 2.1.5

Change Information in the 
Properties

Add values to document 
properties.

1.4.6

dvannncededed Prooopepeperties  totto opennn ttthe Propeeertties dddialog boboxxx, and
ary tababab to maaakkke it accctttiveveve. 
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 Knowledge Assessment 

   Multiple Choice 

 Select the best response for the following statements. 

1. Which Word feature enables you to select multiple pieces of text that are not next to 
each other? 
a.  Multi-selection feature 
b.  Multi-task feature 
c.  Multi-select all text feature 
d.  Ctrl 1 A feature 

2.                           are reduced-size versions of images.
a.  Thumb drives 
b.  Thumb documents 
c.  Thumbnails 
d.  Preview panes 

3.  The Advanced Properties allows you to add: 
a.  keywords. 
b.  category. 
c.  author’s name. 
d.  All of the above 

4.  In what view is Synchronous Scrolling active? 
a.  Split 
b.  Arrange All 
c.  New Window 
d.  View Side by Side 

5.  When Heading Styles have been applied to a document, the user has the option to 
navigate through the document using which tab on the Navigation Pane? 
a.  Headings 
b.  Pages 
c.  Results 
d.  None of the above 

6.  Commands for replacing text with formatted text are located in the: 
a.  Find and Replace dialog box. 
b.  Advanced Find in the Navigation Pane. 
c.  Dialog box that opens when you press  Ctrl + H . 
d.  All of the above 

7.  The keyboard shortcut for fi nding text is: 
a.  Ctrl 1 H. 
b.  Ctrl 1 F. 
c.  Ctrl 1 G. 
d.  Ctrl 1 5. 

8.  The Replace command can be opened using: 
a.  the Find and Replace dialog box. 
b.  Ctrl 1 H. 
c.  Advanced Find in the Navigation Pane. 
d.  All of the above 

9.  Which wildcard would you use to fi nd a single character? 
a.  ? 
b.  * 
c.  ** 
d.  ?? 

10.  The Go To command allows you to navigate by page, text, graphics, equations, or 
tables by doing which of the following? 
a.  F5 shortcut key 
b.  Find and Replace dialog box 
c.  Ctrl1G 
d.  All of the above 

tetet googory.
thhhorrr’s namamame. 
l ofofof thehh aaabobb vvve 

hat vvviewewew is SySySynnnchronnnoous Scccrooolling actttivve? 
plit



Lesson 264

True/False

Circle “T“ if the statement is true or “F“ if the statement is false.

T F 1. The New Window command launches a new window that contains the current 
document.

T F 2. By selecting text, the user has the ability to change the font or font size, bold, 
and delete text.

T F 3. Read Mode view displays the document as it will look when printed.

T F 4. The Zoom slider is located in the View tab.

T F 5. The Synchronous Scrolling button is used when viewing documents side 
by side.

T F 6. The Switch Windows command allows you to toggle between documents.

T F 7. Double-clicking a word in a document selects the word.

T F 8. When you type text in the search box while in the Navigation Pane, Word 
identifi es this text by bolding the results in the document.

T F 9. The Arrange All command places all open documents in a separate window on 
the screen.

T F 10. You can use the Navigation Pane to search for words or phrases in a document.

 Competency Assessment 

 Project 2-1: Updating a Sign 

 The Grand Street Coffee Shop places a sign on the door and near the order counter listing the 
featured coffees of the day. You need to update today’s sign. 

  GET     READY  .   LAUNCH  Word if it is not already running. 

1.  Click  Open Other Documents from the Recent screen . 

2.  Under the Open screen, click  Computer , and then click  Browse . 

3.  Click the location of the data fi les for this lesson. 

4.  Locate and open the  Sign    document. 

5.  Click the  File  tab, and then click  Save As . In the File name box, type  2-1 New Sign . 

6.  Click  Save . 

7.  Position the I-beam before the  M  in  Morning Blend . Drag over the words to select 
 Morning Blend . 

8.  Type  Grand Street Blend . 

9.  Click the  Home  tab. In the Editing group, click  Replace . 

10.  Place the insertion point in the Find what text box and type  Kona Blend.  

11.  Click in the  Replace with  text box and type  Hawaiian Blend . 

12.  Click the  More  >  >   button. 

13.  Click the  Format  button and select  Font . 

14.  In the Replace Font   text box, click the scroll bar down arrow and select  Comic Sans MS ; 
for the Style, select  Bold Italic ; for the font size, select  26 ; and for the font color, select 
 Dark Blue  in the Standard Colors. 

15.  Click  OK , and then click the   <  <  Less  button.  

16.  Click  Find Next , and then click the  Replace  button. 

17.  Click  OK , and then click  Close . 
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18.  Position the I-beam before the  T  in  Try Me  and click to place the insertion point. 

19.  Type  $2  and press the  spacebar . 

20.  In the next line, double-click the word  Mocha  to select it. 

21.  Type  White Chocolate . 

22.  In the Zoom group, click  Page Width . 

23.  Click  One Page . 

24.  Click the  Save icon  in the Quick Access Toolbar. 

25.  Click the  File  tab. Click  Print , and then click the  Print  button. (Check with your instructor 
before you print this document.) 

26.  Click the  File  tab and select  Close . 

  PAUSE. LEAVE  Word open for the next project. 

 Project 2-2: Editing a Job Description 

 Star Bright Satellite Radio is hiring. Edit the job description so that it can be sent to the human 
resources department for processing and posting. 

  GET     READY  .   LAUNCH  Word if it is not already running. 

1.    Click the  File  tab and choose  Open . 

2.  Click  Computer , and then click  Browse . 

3.  Navigate to location of the data fi les for this lesson. Locate and click  Job Description   
 one time to select it.  

4.  Click  Open . 

5.  Click the  File  tab, and then click  Save As . In the File name box, type  2-2   Updated Job 

Description  .  

6.  In the second line of the document, position the I-beam before the  D  in  Date  and click 
to place the insertion point. 

7.  Beginning at the  D , click and drag down and to the right until  Date Posted  and the line 
below it,  5/15/10 , is selected. 

8.  Press  Backspace  to delete both lines. 

9.  In the  Duties & Responsibilities  heading, position the insertion point before the  & . 

10.  Press  Shift  +  Right arrow  to select  & . 

11.  Type  and . The  &  is replaced with the word  and . 

12.  Position the mouse pointer in the left margin beside the line in the fi rst bulleted list that 
reads  Defi ne the web site’s look and feel.  Click to select the line. 

13.  Press the  Delete  key to delete the line. 

14.  In the  Education and/or Experience  heading, position the I-beam to the right of the 
letter  r  in  or . 

15.  Press  Backspace  three times to delete the  r ,  o , and  / . 

16.  In the fi rst line of the bulleted list that begins  College degree required . . ., click to 
position the insertion point after  master’s degree.  

17.  Press the  spacebar  and type  preferred . 

18.  Click the  View  tab. In the Zoom command group, click  Zoom , click  75% , and click  OK . 

19.  On the Zoom command group, click  Page   Width , and then click  100%.   

20.   SAVE  the document in the lesson folder on your fl ash drive then  CLOSE  the fi le. 

  PAUSE. LEAVE  Word open for the next project. 

ttthehehe File  tatatab anddd cchc oooooses  OpOOpenen .

Cooommpm utututeree , anddd thennn cclick  r BrBrrowse . 

gateee tooo locaata ioioionn of thehhe dataaa fi fifiles for thhhiss lessoss n. Locccattte an
time tototo seleccct tt it.  
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 Profi ciency Assessment 

 Project 2-3: Creating a Schedule 

 You are chair of the New Neighbor Welcoming Committee in your neighborhood. The group 
meets monthly at a committee member’s house. A different committee member is responsible for 
bringing refreshments to each meeting. Use Word to create a schedule to share with members, and 
then view the document in different views. 

GET READY  .   LAUNCH  Word if it is not already running. 

1.   OPEN     Schedule    from the data fi les for this lesson.  

2.   SAVE  the fi le as  2-3 Updated Schedule  in the lesson folder of your fl ash drive. 

3.  For the May 11 meeting details, beside  Meeting place , type  D.     Lorenzo, 7501 Oak, 

8 p.m.  Beside  refreshments , type    S. Wilson . 

4.  The June 15 meeting details are  R. Mason, 7620 Oak, 8 p.m. ,   and  J. Estes  is bringing 

the refreshments. 

5.  View the document in a  New   Window . Then click  Switch   Windows  to display the 
window ending in “:1”. 

6.  Click  Web Layout , and then click  Draft  view. 

7.  Click the  Split  button, and reposition the split under the second title,  Meeting and 
Refreshment Schedule  and review. Click  Remove   Split . 

8.  Return the document to  Print Layout  view. 

9.  Remove the blank paragraph located above  January 7 . 

10.   SAVE  the document in the lesson folder on your fl ash drive then  CLOSE  the fi le. 

  PAUSE. LEAVE  Word open for the next project. 

 Project 2-4: Copying and Pasting Text 

 In this exercise, you work with a document that you created in Project 1-5 and apply the skills that 
you learned in this lesson. You also save the document in the Word 2013 format. 

GET READY  .   LAUNCH  Word if it is not already running. 

1.   OPEN     1-5 Thanksgiving Menu  from your Lesson 1 folder. 

2.   SAVE  the document as  2-4 Thanksgiving Menu  in the lesson folder on your fl ash drive. 

3.    Follow the steps as listed under  Menu , on the right side of the document. 

4.   SAVE  the document in the lesson folder on your fl ash drive then  CLOSE  the fi le. 

  PAUSE. LEAVE    Word open for the next project. 

 Mastery Assessment 

 Project 2-5: Fixing the Coffee Shop Menu  

 A co-worker at the Grand Street Coffee Shop has been working on a new menu for the coffee shop. 
She asks you to take a look at it before she sends it to a graphic designer. You fi nd the old menu fi le 
and decide to compare the two. 

www eenddnding innn “:1”.

eb bb LaLaLayooututut , aaanddd ttthenn clllick  DDrD aafa t  view.
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  GET     READY  .   LAUNCH  Word if it is not already running. 

1.   OPEN     Menu    from the data fi les for this lesson. 

2.   OPEN     Old Menu  from the data fi les for this lesson. 

3.  View the two fi les side by side to compare them. 

4.  Find and insert the two items that are missing from the new menu. 

5.  Find and change fi ve pricing errors on the new menu. 

6.  Delete the blank paragraph in the document. 

7.   SAVE    the corrected menu as  2-5 New Menu  in the lesson folder on your fl ash drive, 
and then  CLOSE  the fi le. 

8.   CLOSE  the  Old Menu  fi le. 

  PAUSE. LEAVE  Word open for the next project. 

 Project 2-6: Creating a New Memo 

 You open a new memo that was created using one of Word’s template. In this project, you use the 
copy and paste commands.  

  GET     READY  .   LAUNCH  Word if it is not already running. 

1.   OPEN   Business Memo  from the data fi les for this lesson. 

2.   SAVE  the fi le as a template and name it  2-6 Welcome Memo  in the lesson folder on 
your fl ash drive. 

3.    Select  December 18, 20XX  in the date placeholder. 

4.  Type the following information in the placeholders: 

  To:   Dorothy Martinez  

   Ann Smith  

       Dell Najera  

       Patty James  

  From:   Sara Wilson  

  Re:   Planning Committee  

5.     Delete  the CC placeholder. 

6.   OPEN   the   Welcome Memo    document you created in Lesson 1. 

7.  Display both documents on your screen using the View Side by Side command. 
Beginning with  Thank you for volunteering  to the end of the paragraph, copy to the 
placeholder under  Comments . 

8.   CLOSE  the  Welcome Memo  document without saving. 

9.   SAVE  the updated changes to the  2-6 Welcome Memo  document in the lesson folder 
on your fl ash drive, and then  CLOSE  the fi le. 

  STOP. CLOSE  Word.  

N    Buuusineeessssss Memmmooo frfrfrfromomom thehehe dddata fi les s s fofoforrr thththisisis lesesessososoon.o
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